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Innledning

Denne manualen beskrive virkemdten, ingtallasion, formater og resultater til et
programmet som er utviklet for & beregne ADT.

Programmet bestér av to deler. | den ferste delen beregnes ADT pé grunnlag av tellinger
av antall biler som har passert et malepunkt pr time. | den andre delen plottes uke/dagn-
variasjoner 0g sesong-variasjoner.

Dokumentasjon av beregningsmetoder kan finnes i notatet Ny metodikk for
trafikkberegninger pa grunnlag av tellinger STAT/07/97 (Aldrin og Follestad, 1997).

Programmet er utviklet for PC som har operativsystemet Windows 95 eller Windows NT.
Videre er programmet utviklet for Excel 97.

Installering av programmet

Programmet AADT er en Excel makro, utviklet pa Excel 97. For teknisk dokumentasjon
av Excel 97 og Visual Basic anbefales en vanlig laaebok som f eks Excel/Visual Basic
Programmer’s Guide.

Programmet leveres som et Excel regneark samt en mengde parameterfiler og filer for
basisfunksjoner.

Programmet (dvs makroen knyttet til regnearket), samt de tilharende filene er pakket inn
ved hjelp av WinZip 6.2. Den pakkede katalogen har navnet Trafikk.zip.

Fer installering og utpakking av denne katalogen ma det opprettes en katalog der
programmet skal vaae. Denne katalogen skal hete:

D:\Trafikk\

Etter a denne katalogen er opprettet kan man pakke ut innholdet i den komprimerte
katalogen. Felg da falgende oppskrift:

Start WinZip

Klikk pa Open opsjionen i det gverste panelet.

Finn katalogen Trafikk.zip

Klikk pa Extract

Finn katalogen D:\Trafikk\ under Folders/Drivers.
Klikk Extract

oS hkhwbdpE

Na overfares filene fra den komprimerte katalogen til katalogen D:\Trafikk\. De
aktuelle filene er Trafikk.xls, Param.xls, blxyyyy.dat, der x er fra 1 til 5 og der yyyy er
fra 1994 til 2002 (pr desember 1997), dagyyyy.dat, bsesl.xls 0g bukel.xls.
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Beskrivelse av filene:
Trafikk.xls: Dette regnearket inneholder makroen AADT
Param.xls: Dette regnearket inneholder ark med parameter samt mal for resultatfil.

Bsesl.xls: Dette regnearket inneholder fem ark. Hver av arkene inneholder basisfunksjon
til plotting av sesong variasjoner for de fem ulike lengdeklassene.

Bukel.xls: Dette regnearket inneholder fem ark. Hver av arkene inneholder basisfunksjon
til plotting av uke variasjoner for de fem ulike lengdeklassene.

blxyyyy.dat: Dette er et sett med basisfiler som brukes i programmet. Bokstaven x star
for lengdeklasse, mens yyyy stér for arstall.

dagyyyy.dat: Dette er filer som inneholder informasjon om forholdet mellom ukedag, og
arstime. Arstime er et begrep som sier noe om hvilken time i &ret em gjelder for en gitt
dato. | et normaldr er det 365 x 24 arstimer, mensii et skuddar er det 366 x 24 arstimer.

E18Frut.dat: Tellinger for en vei (E18 Frognerstranda mot Drammen) malt to uker i
begynnelsen av dret. Dette er en eksempelfil, der formatet til tellingene kan studeres. Fila
inneholder 336 observasjoner (timebasis) for fem ulike lengdeklasser.

Kjoring av programmet
Man starter programmet ved:

Start Excel

Deretter dpnes arket D:\Trafikk\Trafikk.xls. (File->Open->)

Under Tools -> Macro -> Macro (Alternativt Alt + F8) dpnes makroen AADT.
Velg AADT

Klikk pd Run og du har startet programmet.

gsowp=

Du vil na bli spurt om falgende ting.

1. Skriv inn katalognavn der tellefil(ene) befinner seg.
Default katalog er D:\Trafikk\

2. Skriv inn filnavn patellingene (format beskrives under)
Default filnavn er E18Frut.dat. Denne filama vage i katalogen gitt over.

3. @nskes beregninger av prognoser patimebasis? Her er svaralternativene ja eller nei.
@nskes bekreftende svar kan man skrive JA, Ja, Jeller j.
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4. @nskes utskrift av resultater for ADT, standard avvik til ADT ? Svaralternativer som
over.

5. @nskes estimerte/observerte timesverdier for hele dret. Svaralternativer som over.

6. @nskesdiagrammer for uke(degn variasioner samt sesong variasjoner?
Svaralternativer som over.

N& beregner programmet ADT verdier for de fem ulike lengdeklassene. Tiden for disse
beregningene vil vaxe svaat avhengig av maskintype og tilgjengelig minne. Det
anbefales & ha minst 32MB RAM minne tilgjengelig. Det anbefales ogsa a bruke en
maskin med en prosessor a 133MHz eller raskere.

Hvis noe gar galt med default fila (D:\Trafikk\E18Frut.dat) kan det vage to muligheter.

1. Det kan vagre ulike tegnsett for de Excel versjonene, slik at programmet oppfatter
tegn ulikt for ulike maskiner. Produktet er utviklet for norsk tegnsett, der komma er
gitt som”,” og ikke”.”.

2. Det kan vage galt med innlesing eller installering.

Hyvis noe gar galt ma man fjerne alle ark (sheets) i boka Trafikk.xls (unntatt arket
TRAFIKK ellers slettes hele boka) for man starter pa nytt. Videre ma man lukke
alle regneark med unntak av Trafikk.xls.

Formater

Input
Her skal vi se pa formatet til tellefila. Denne fila skal vagre som vist i tabell 1. Pr idag vil
resultat arket ha likt navn som denne fila, men der de fire siste tegnene er fjernet.

Tabell 1: Format av tellefil.

95 1 5 1 222 29 8 3 11
95 1 5 2 111 11 4 7 10
95 1 5 3 71 15 4 4 4
95 1 5 4 57 12 4 2 8
95 1 5 5 53 4 3 1 4
95 1 5 6 233 32 12 9 13
95 1 5 7 1263 119 34 16 17

Det skal ikke vaare noen heading pa denne fila og den skal lagres som en vanlig ASCII
fil. De ulike spylene skal vaae adskilt med Tab eller et blankt tegn og skal ha falgende
betydning:
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Tabell 2: Forklaring av de ulike kolonnene i tellefila.

Kolonne nr. Variabel

Arstall. Denne verdien leses inn av programmet.

Maned 1 -12

Dag1-31

Timel-24

Antall biler for den aktuelle timen for lengdeklasse en

Antall biler for den aktuelle timen for lengdeklasse to

Antall biler for den aktuelle timen for lengdeklasse tre

Antall biler for den aktuelle timen for lengdeklasse fire

O N0 WNEF

Antall biler for den aktuelle timen for lengdeklasse fem

Arstall kan veare skrevet fult ut som 1995 eller som verdi mellom 0 og 100 som 95.
Output

Resultat fra en tellefil vil bli skrevet ut pa et eget ark i boka Trafikk med samme navn
som tellefila.

Tabell 3: Hovedresultater fra programmet.

Lengdeklasse|1 2 3 4 5
AADT 29912,9 3135,5 803,5 365,7 387,8
Stand avvik [1098,0 317,0 93,8 45,1 76,8
Ant faktorer |8 4 8 8 8

Antall biler |10918221,2 |1144475,5 293280,8 133474,0 141553,7

Chat 884,3091 90,71672 27,09998 8,430762 10,19792
alfa1 1,023686 1,002498 1,109481 1,233352 1,283841
alfa2 0,121862 1,50416 0,642585 -0,20426 0,479293
alfa3 -0,58509 0,360697 1,271036 0,948856 -0,17252
alfa4 0,840614 0,650721 1,925912 -1,08727 -0,1848

alfab -0,73496 0,536106 -0,85433 1,522269
alfaé 2,057144 0,45326 0,08976 -0,31719
alfa7 0,944296 -1,09044 -0,89778 0,443641
alfa8 1,983516 -1,58562 -0,59482 -1,00422

De fire farste radene gir informasjon om lengdeklasse, beregnet ADT, usikkerheten
knyttet til dette ADT estimatet (standard avvik) samt antall basisfaktorer som er brukt
under beregningene. @nskes et 95% konfidensintervall for ADT verdien beregnes dette
intervallet som ADT estimatet +/- 2.0 standard avviket til ADT. For eksempelet over i
Tabell 3 vil et 95% konfidensintervall for ADT parameteren for lengdeklasse 1 vage
29912,9 +/- 2.0 * 1098,0. Dette gir intervallet (27716.0, 32108.9).
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De ni neste radene inneholder informasjon om de estimerte parameterene som
karakteriserer de ulike basisfaktorene. Disse parametrene samt metoder for hvordan de
blir estimert er dokumentert i Aldrin og Follestad (1997).

| tillegg vil man kunne skrive ut de beregnede/observerte timesverdier for hele aret pa
timebasis pa dette arket. Disse vil vage gitt frarad 31 og nedover. Et normalér har 365 *
24 arstimer, mens et skuddar har 366*24 arstimer. Denne tabellen vil dermed ha de
estimerte verdier for de arstimer der det ikke er tellinger, mens de observerte verdiene er
gitt der man har tellinger.

Tabell 4: Estimerte/observerte timesverdier for de ulike lengdeklassene.

Beregnet/observert antall biler pr timer

1 2 3 4 5
1 343,37 26,56 2,34 0,98 0,90
2 314,74 26,86 1,99 1,26 0,90
3 257,52 24,77 1,27 1,25 0,86
4 230,98 23,10 1,38 1,22 0,85
5 184,70 18,13 1,77 1,03 0,70
6 136,54 12,43 2,09 1,02 0,67
7 155,73 12,94 3,14 1,42 0,71
8 213,07 14,36 4,20 1,72 0,82
9 249,69 18,19 4,81 2,46 1,01
10 412,04 29,84 7,71 3,68 1,81
11 655,27 41,35 8,29 3,42 2,17
12 860,84 52,63 8,57 3,52 241

Resultatet legges til Excelfila Trafikk.xls som et nytt ark. Navnet pa resultatfila for den
farste veilenken blir som navnet pa datafila, men de fire siste tegnene blir fjernet. @nsker
du & state programmet etter en gammel kjering ma du skifte navnet pa dette arket
(Format->Sheets->Rename).

Hvis man har svart bekreftende pa utskrift av resultater til fil vil disse bli skrevet ut pa
fila *.txt, der * er navnet pa resultatarket fratellefila.

Fra plotterutinen vil man fa laget to typer diagrammer. Hver av typene vil bli produsert
for de fem lengdeklassene. Den ene typen er sesong-variasjoner, mens den andre typen er
uke/degn-variasjoner. | figur 1 og 2 er disse to diagrammene vist. 100% er brukt som
referanseverdi.
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Uke og degn variasjon for lengde klasse 1
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Figur 1: Uke og dogn variasjoner for lengdeklasse 1.
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Sesong variasjon for lengde klasse 1
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Figur 2: Sesong variasjoner for lengdeklasse 1.

Korreksjon til metoderapport

Trafikkberegningsprogrammet er basert resultater publisert i Aldrin og Follestad (1997).
Beregningene i denne rapporten er utfart pa grunnlag trafikkdata fra 16 veier i 2
retninger. | ettertid har vi oppdaget vesentlige feil i dataene for lengdeklasse 2 og 3 i en
retning for en bestemt vei. Tabell 6 og 9 i rapporten er derfor beregna pa nytt uten bruk
av data fra denne ene veilenka. De nye beregningene er gjort for alle lengdeklasser.

De korrigerte tabellene er gjengitt nedafor. Det er disse som er implementert i

trafikkberegningsprogrammet.
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Tabell 5: Korrigerte verdier for tabell 6 STAT/07/97 Soylene gir verdier for de ulike
basisfaktorene.

0

1

2

3

4

5

6

7

8

332,4297

269,5848

113,826

63,7742

63,0481

71,13092

65,83757

64,07587

67,13242

55,81574

49,19567

32,51423

29,40697

31,45662

49,28414

84,75686

87,27572

94,48355

36,64208

32,04758

17,97162

20,30664

30,04062

38,18018

38,14658

38,48166

39,27529

30,63533

26,60889

23,65073

24,30763

26,598

32,33954

31,85417

33,71203

34,56833

42,64015

33,73834

39,79725

45,7805

47,90366

52,875

54,46411

56,18382

59,05043

1,14066

1,09983

1,1864

1,2361

1,25236

1,25524

1,28266

1,2976

1,31341

-0,07496

-0,05878

-0,04919

-0,11155

-0,10264

-0,10625

-0,10581

-0,11051

-0,11806

-0,17594

-0,16203

-0,14856

-0,15627

-0,17031

-0,17663

-0,17809

-0,18185

-0,18551

-0,0913

-0,06891

-0,08228

-0,08873

-0,09511

-0,10966

-0,11064

-0,11911

-0,12817

-0,06499

-0,0855

-0,1127

-0,11702

-0,13388

-0,14986

-0,15715

-0,16283

-0,17716

0,04505

-0,0362

-0,05434

-0,05933

-0,08481

-0,10931

-0,1245

-0,13356

-0,13837

0,0132

-0,04086

-0,05878

-0,0599

-0,07598

-0,0876

-0,09629

-0,10918

-0,11928

0,0603

-0,00981

-0,02575

-0,02658

-0,0518

-0,06907

-0,07595

-0,08243

-0,09494

0,00577

-0,03483

-0,0617

-0,07209

-0,09985

-0,10741

-0,11778

-0,1259

-0,13259

0,10289

0,03058

0,01551

0,01151

-0,01484

-0,03193

-0,03848

-0,05361

-0,06421

Tabell 6: Korrigerte verdier for tabell 9 STAT/07/97. Soylene gir informasjon om de ulike
lengdeklassene.

1

2

3

4

5

2,57704

0,46261

21,65927

19,35205

68,50291

1,43293

1,70395

1,10977

1,02082

0,93486

-0,06827

-0,07047

-0,07234

-0,03837

-0,06194

-0,10695

-0,17687

-0,23908

-0,15673

-0,17707

-0,06496

-0,06971

-0,05666

-0,09401

-0,07916

-0,09565

-0,05098

-0,07957

-0,05619

-0,06089

-0,0438

0,00419

-0,00363

-0,01488

-0,02077

-0,04687

-0,02875

-0,0121

0,00333

0,03166

-0,01186

-0,00964

-0,01183

0,02458

0,0344

-0,06504

0,00676

0,01378

-0,01305

-0,02917

-0,0019

-0,00068

0,03929

0,06219

0,11479
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